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Creating a Resizable Box/Template by Using Components and Parameters 
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Task 

In this exercise, you will learn how to make a resizable design from components. We will use a smart, 
parameter-controlled approach that ensures that each time you change a parameter in the structure, 
the structure will be recomputed and resized automatically. 

NOTE: The scenario that follows describes the steps for creating a production-ready resizable box from 
ready-to-use components. But you can use the scenario also for creating a “live” resizable template that 
you can use in the future – for example, to modify its structure and parameters and create a different 
box. The steps for the two projects are identical – but see the IMPORTANT note in Step 2 in the 
Preparation section. 

We will load components from the Synergy Components library. We will use the advanced parameter 
matching functionality, which moves the parameters of a component – compound or individual – to 
those of the entire project after the component has been attached to become part of the project. 

Complete folding box 
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EXERCISE DESCRIPTION 

Before you start 

Before you start, you need to make sure that the Advanced Parameter Matching functionality is turned 

on. To do this, on the Tools menu, click Options, then click the Synergy tab; in the Show group, make 

sure the Advanced parameters matching check box IS SELECTED. 

Preparation 

1. To begin creating a new box project, do any of the following: 

 On the File menu, click New. 

 In the toolbar, click the New Project . 

The Material dialog box appears. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. To begin creating a project from scratch, click Blank Drawing. 

IMPORTANT: If you want to create a resizable template file (.evr file), click the Resizable Template 
option. Then proceed with the steps of the scenario as described in this document. 

3. In Base type, select Folding Carton Cardboard, and then, in Name, select the material that you 

want to work with. 
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4. To begin working on the project, click Finish.  

5. To show the tabular area, do any of the following:  
  On the View menu, click Tables in the menu bar. 

 
 On the lower right corner, click the Show/Hide button 

 
 

.
 

 
 

6. Click the Parameters tab. 
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As we have no drawing to work with, when the blank drawing opens, the Parameters tab is empty. 

NOTE: The Parameters tab is the tabular area that lists all the parameters in the project. This is the 
area in which parameters are edited, which changes a resizable structure's size. 

7. Click the Synergy Components tab, and then click the Synergy Components dropdown menu; 
then click the Synergy Components folder. 

The library's subfolder structure appears. 
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Positioning the base 

1. We begin by creating the base component: click the Bases folder. 

A list preview of the available bases appears in the right-hand area. 

2. Select the component 01 Four Panels. 

A preview of the selected component appears in the area below the component list. 



ENGVIEW PACKAGE & DISPLAY DESIGNER TUTORIAL — CREATING RESIZABLE BOX FROM COMPONENTS | PAGE 7  
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3. Holding down the mouse button, begin dragging the component into the graphical area. 
 

 

4. When you decide where to place the component, click. 

The Component Parameters dialog box opens. 

 
 
What do these check boxes in front of parameters mean? 

 

As we are working in the Advanced Parameter Matching mode, selected check boxes appear in front of 

the rows in the table. What does this mean? 
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Let us take a look at the second row, where the #A parameter is. We can see that the distance 

indicated with #A will be linked to the parameter A (seen in the Design Name column) and this 

parameter will appear in the parameters list with an expression 90. This distance will later be editable 

through the expression of the parameter A. 

Why are the rows with selected check boxes highlighted in blue? 
 

These rows are highlighted in blue, because the parameters (in the Design Name column), which will 

be linked to the component's dimension lines, are new for the drawing; they are not listed in the 

Parameters tab list. Highlighting the parameters means that the parameters named A, B, H and B1 will 

be added to the Parameters tab list. In this way, the corresponding distances will be editable through 

these parameters. 

NOTE: If we choose to clear a check box, no parameter will be associated with the distance and this 

distance will not be editable later in the Parameters tab list: 
 

 
 
What about the #d? 

 

The material thickness can be used during the creation of components that will be used for assembling 

the resizable design. For example, creating the component 01 Four Panels is based on the idea that the 

rightmost panel needs to be shortened by one material thickness. For this purpose, the parameter d  

has been created, which is used in the expression of the parameter B1 (B1=B-d). 

When this component is used during assembly of a resizable design, the parameter d is automatically 

substituted with d(). This is a function that extracts the material thickness from the drawing's properties. 

This means that we need no special parameter to indicate the thickness. That is why the check box in 

front of #d is unselected and its Design Name column field is empty. 

5. To position the base, click OK. 
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6. To exit the component-placement mode, click ESC. 

The base is now in the graphical area. 

 

7. In the tabular area, click the Parameters tab. Note that we now have four new parameters. 

8. To show dimensions of the component, do any of the following: 

 In the graphical area, right-click the base, point to View, and then click Dimensions. 
 

 



This means that we are now able to use the parameters in the tabular area to edit the size of the base.
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 Click the base to select it. Then on the contextual edit bar that appears above the graphical area, 

click Show component dimensions . 
 
 

 
 

Note that in the base the indicated distances are linked to parameters in the tabular area. 
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9. In the Expression column, make A=130. 

Note that two of the panels in the base have been resized. This is because the parameter A is linked to 
two distances in the component. 

10. Make B=55. 

Note that two more panels have been resized too. The first resizing took place because the panel's 
dimension line is directly linked to the parameter B. The second panel was resized because its 
dimension line is linked to the parameter B1, which is indirectly linked to B: Its expression is B-d(). 

11. Make H=155. 

Attaching the bottom 

1. To add the bottom, in the tabular area, click the Synergy Components tab, and then click the 
Synergy Components dropdown list. 

2. Browse the sequence Compound Components | 01 Tops and Bottoms | 03 Snap Lock. 

3. Select the component 01a Snap Lock (Rounding.STC.SEC). 

4. Drag the component to the base and attach it to the lower part of the base. 
 

 

After you have attached the last point of the component, the Component Parameters dialog box 
opens. 

 
 
How to read the table 

 On one hand after the attachment, the bottom component has been recalculated to fit the base 
because the component-level parameters #AX2 and #AX3 link the structure that we are 
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attaching to the base. This took place because the values for #AX2 and #AX3 were 
automatically extracted from the respective values in the base. What’s more, as in the 
Parameters tab list there are already parameters that have the same values (in this case A and 
B), the program links #AX2 and #AX3 to the parameters B and A, respectively: 

 

 

IMPORTANT: It is critical that the expressions of parameters #AX2 and #AX3 contain the 
parameters that control the design's main sizes – in this case the parameters A and B. Thus the 
attached bottom will recalculate each time the values of A and B change. 

NOTE: By default, the two parameters are unselected, because they have been substituted by 
the parameters A and B 

 On the other hand, when the compound component was created dependencies were set in the 
parameters' expressions between the distances AX2 and AX3 and the distances that form the 
compound component. In this way, when the compound component is used in the assembly of 
a resizable design, its parts are recalculated thanks to the information that comes from AX2 and 
AX3: 
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NOTE: The above picture is from the parameteric components design module (formerly 
Synergy). It offers an idea of how a compound component is created. 
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NOTE: To see the parameters DySTB and SBH, in the tabular area, right-click, and then click 
Show Hidden. 

 The rest of the parameters in the compound component – the ones highlighted in blue --- will be 
transferred to the project and will appear in the parameter list. Some of them have their own 
preset expressions, which are necessary for the calculation of the attached structure. Some of 
these preset expressions ensure the correct recalculation of the bottom when the design's main 
parameters (A and B) are changed – for example SBH. Other preset expressions set 
dependencies between the parts of the bottom – for example, SBHW and STTW: 
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At this stage, using parameters has the advantage that we can trust their default values and not go 
into any detail. We can always control the bottom later when we edit the expressions of the 
parameters in the Parameters tab list. Consider the following example: During attachment, we 
have a much larger radius of rounding at the bottom’s base (pictured). We can change this later. 

 

 

5. To close the dialog box, click OK. 

The snap lock is now part of the design and thanks to the use of parameters and their expressions 
it will be recalculated automatically each time the basic parameters of the design are change. 
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6. Make the parameter B=65. 

Note that also the bottom changed. One critical dimension is, for example: 
 

 

NOTE: To see the dimension lines in a component, select the component. 

Тhis distance will always be correct when the parameter B is given a new value, because in compound 
component the formula AX2/2 is preset. During the attachment of the component it becomes B/2. 

By analogy, this applies also to the parameters STTH, DySTB and DySEB. 

Note that not all expressions in the component are obligatory or critical. For example, the expression of 
the parameter STTH=0.15*B is freestanding – that is, it can be edited or even substituted with a concrete 
numerical value. 
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7. Make the parameter STTH=15. 

Note that also the height of the tongues of the middle panel is changed. 

This took place thanks to the use of parameters and the fact that one and the same parameter controls 
the respective distances in the two components. 
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Here the heights of the two other flaps have been changed, because the expression of the parameter 
SED contains a calculating mechanism that uses the parameter STTH. 
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Editing the roundings 

Now let us focus on the roundings and find out which parameter controls them. We will use the 
Trace Object Selection functionality, which highlights the parameters linked to a distance or a 
component that we point to in the graphical area. 

1. To turn on the functionality, in the tabular area, right-click and then check Trace object selection. 

2. As there are roundings in all parts of the bottom, select any one of them. 
 

 

In the graphical area we can see the component's dimension lines and the parameters linked to them. 
Тhe parameters linked to these distances are indicated in the tabular area. This is how we can quickly 
find the parameter R and edit its value to 1. Note that in this case a minimum-value threshold exists: The 
value of the parameter cannot be smaller than the value of the parameter Off (located right above the 
parameter R in the parameter list). If we want R to adopt the value 0.5, we need to reduce the value of 
the parameter Off. 

3. Make the parameter Off=0. 

Now the parameter R can adopt the value 0.5. 

Note that all the roundings have become smaller, not only those in the selected component. Тhis is due 
to the role of parameters. In this case, the parameter R controls all the roundings in the bottom’s 
individual components. 

Editing the shape of the small flaps 

4. Make the parameter SEB=10. 

The shapes of the two flaps changed because a parameter exists that controls them. 
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Now we will round the edges that have appeared. 

5. On the Objects, click Fillet, and then, in Radius, type 5 and then press ENTER. 

6. Ensure that the Smart Fillet button  is pressed in. 

7. In the graphical area, make the two roundings. See the following example. 
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Assembling the top of the box  

Attaching a panel 

1. In the Synergy tab in the tabular area, browse the sequence Individual Components | 01 

Geometrical Shapes | 01 Rectangles | 01 Rectangle (Layer). 

2. Drag the component into the graphical area and attach it. 
 

 

The component's table of parameters appears. 
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Four new parameters (highlighted in blue) will go into the list of parameters: 
 

 UL: When it has the value Yes, moves up the crease. When it has the value No, it makes the 
crease level with points of attachment. 

 

 LSC sets the step of moving the crease. While the component is being created, the program 

ensures that this parameter's value is equal to the material thickness. 

 PH sets the panel height. 
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About the use of layers (the parameter UL) 
 
If we leave the UL row selected, UL will go to the parameter list, and this will add flexibility to the 
structure: If we make UL=No, creases will become collinear (it will not be offset). 

But if we do not need this flexibility: We need to clear the check box in front of UL and in Expression 
choose either Yes or No. In this case we will discard the flexibility option: 

3. Clear the check box and select Yes. 
 

 

4. Click ОК. 

5. To exit the component-placement mode, press ESC. 

Two new parameters appeared in the parameter list: LSC and PH. 
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6. The height of the attached panel cannot be free: In the expression of PH, put a formula: B-d(). 
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Attaching a tuck end 

1. Browse the sequence Individual Components | 12 Tongues | 06 Tuck Ends | 02 Tuck End. 

2. Begin dragging the component into the graphical area. Then, before attaching it to the rectangle, 

on the contextual edit bar above the graphical area, click Show component dimensions  to 
make visible its dimension lines. 

3. Click OK. 

4. Press ESC. 

Three new parameters have gone into the parameters list: TEH, TER and TEC. 

5. Normally TEC equals the material thickness: Make TEC=d(). 
 

 
 

Let us hide the dimension line showing the TEC value: We have already a rule for that and we need not 
see something that we know works correctly. 

6. Point to the parameter line, and when it is highlighted, right-click, and then click Hide. 
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Attaching a trapezium 

1. Browse the sequence: Individual Components | 01 Geometrical Shapes | 02 Trapeziums | 01b 
Trapezium (TopW.Layer). Drag the component, and attach it to the third panel of the base. 
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Note that LSC is selected but is not highlighted. This means that a parameter, LSC, will be used for the 
movement of the crease. But we already have such a parameter in the parameter list. That is, no new 
parameter will be created with this name because such a parameter exists already; that's why the row 
is not highlighted in blue. This means that the program will link the crease movement in the newly 
attached component to the parameter used for moving the crease in the earlier component (the 
rectangle). In the current case we need the two crease movements to be identical, and that is why we 
will leave things as they are. 

Also the new component has parameters UL, and the program offers to take it to the parameter list. But 
we do not need this, which is why we'll clear its check box and will use the value we have already 
chosen (pictured). 
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2. Click ОК. 

3. Press ESC. 

Two new parameters – TPH and TopW – were added to the parameter list. 

4. Make TPH=B-d(); make TopW=55. 
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Attaching a tongue locking system 

1. Browse the sequence: Compound Components | 02 Parts | 01 Tongue Locking Systems | 51 
Tongue Locking System (TTCO.Centered) 

2. Drag the component into graphical area, and before attaching its parts, click Apply Vertical Mirror 
 

 
 

3. Attach the Tongue Locking System. 
 

 

4. We need to link the tongue’s width with the width of the trapezoid’s upper base. That is why, clear 
the TTW check box and in its expression type TopW. 

 
.
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5. To see the changes, click Apply. 

After we click OK, all the parameters highlighted in blue will be added to the project's parameter list. No 
parameter TTW will be created (the Design Name field is empty), because we linked the width of the 
tongue to the existing parameter TopW. 

6. Click OK. 

Due to the preset link in compound components between the individual components, here the tongues' 
widths have been linked to the widths of the slits. After the compound component has been attached, 
this logic was transferred to the project (pictured): 

 

 

 
 

It is good practice to level the two tongues. 
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7. To easily locate the parameter that controls the component's height select the component 1. You 
can see that the parameter that controls the tongue's height is TTH. 

8. In the expression of TTH, type TEH. 
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Attaching flaps 

1. Browse the sequence: Individual Components | 02 Flaps | 02 Flaps | 30 Flap. 

2. Drag the component into the graphical area, and attach it to the last panel of the base. 
 

 
 

The parameters that arrive from the component are new for the parameters list (highlighted in 
blue). 
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3. Repeat Step 56 using Vertical Mirror . 
 
 
 

 
 

NOTE: No rows will be highlighted in blue as these components already exist in Parameters tab 
list (they were added when the component was first attached). As the two flaps need to have the 
same shape, we will use the same parameters each time we need to edit their sizes. 
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4. To exit the component-placement mode, press ESC. 
 

 
 

 
We need to ensure that the flaps' height does not get in the way of the locking system. 

5. In the Max column, for the parameter FH, type (A-TopW)/2, and then change the value to 50. 

The parameter's maximum value guarantees that if a bigger value is entered as an expression, the 
concept of the structure will not be violated. 
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Attaching a thumb cut 

1. Browse the sequence: Individual Components | 10 Cuts | 02 Thumbs and Arcs | 01 Thumb Cut 
(Centered). Drag it and attach it at the place as shown in the next picture. 

 

 
 

Note that the TCR row is not highlighted. This means that a parameter exists in the project's parameter 
list and that this parameter will control the component that's being added. We proceed by allowing entry 
of different values for the two thumb cuts. 

2. Clear the check box in front of the #TCR distance. 
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Note that the Design Name field is now empty and that a number appeared in the Expression field. If 
now we click OK, the thumb cut's radius will be 12 and there will be no parameter to control it. 

We will now create a parameter to control this radius. 

3. In the Expression field, type a name for the new parameter, for example, TCR1, and then press 

ENTER. 

A dialog box appears in which we will create a new parameter. 
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4. In Expression, type the value for the new parameter, for example 15, and then click ОК. 

5. In the Component Parameters dialog box, click ОК. 

There is a new parameter, TCR1, in the Parameters tab list. 
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Making a creasing knife cutting 

We now need to make a section of the creasing knife cutting (pictured). 
 

 

1. On the Transformations menu, click Break . 

2. Select the Cutting style, and then click this section of the crease line. 
 

 
 

 
Attaching the glue panel 

Now we are going to add the glue flap to the left side of the design. 

1. In Synergy Components, browse the sequence Individual Components | 02 Flaps | 01 Glue Flaps. 

2. Select the component 01 Glue Flap (GLA), and then drag it into the graphical area and attach its 
first active point to the bottom left control point of the base. 
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3. Attach the second active point of the glue flap. 

NOTE: Pay attention to the point of attachment. 

 
 

 
 

The Component Parameters dialog box opens. 
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Two different parameters are set in the component for controlling the glue flap's left and right sides. In 
our case these angles can be equal – that is, we do not need two parameters. That is why, clear the 
check box of the #GLA1 row and in its expression type the name of the parameter that will control 
#GLA – GLA. 

 

 

4. To close the dialog box, click OK. 

5. To exit the mode, press ESC. 
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The glue flap is now part of the design. 

There are now two – not three – parameters in the parameter list: GL, which controls the glue flap's 
width, and GLA, which controls the left and right sides. 

 

 
 

6. Save the design. 

IMPORTANT: We've just drawn a box by using components and their parameters. This drafting 
technique has the advantage that links are built between certain distances in the structure. This 
guarantees that the structure will be well-computed each time when any of its sizes are changed, 
and no additional editing will be necessary. 
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